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Collect Data
Selecting Collect Data from the File menu will gather up to the minute data on the current system on which 
CheckIt PRO: Analyst is loaded.        CheckIt PRO: Analyst collects information on system configuration, DOS, 
Windows, OS/2, and system performance.      

The information is saved in a CKD file (<filename>.CKD).      You provide the name and description of that file in 
the dialog box.    We strongly suggest that you use the description field, as the eight letter limitation for CKD files 
may cause confusion.

You do not need to collect data each time you run CheckIt PRO:    Analyst.      However, you will want to collect 
data on your system when you first install CheckIt PRO: Analyst, whenever you make changes to the system (add 
hardware, software, or change the configuration), or if you are having difficulty with your system.

See also:
Save Data As
Load Data



Load Data
With the Load Data command, you can select the    CKD data file from any machine you want to analyze.      You 
can load in the latest data file from your computer, an older data file from your computer, or a file from a totally 
different computer.      When you select Load Data, you will see a    dialog box    to help you select the CKD file you
want to load.      

Note that when you load a new CKD file, any windows in CheckIt PRO: Analyst currently open are not updated 
with the new data at that time.      You need to choose the function again for the new CKD file.

See also:
Collect Data
Save Data As



Menu Structure
When pertaining to functionality differences, the CheckIt PRO: Analyst menu can be separated into three classes.    
These distinctions are based on how CKDATA information from multiple machines is used, how diagnostics are 
performed, and the program support options.

See the special color-coded menu bar and descriptions below for the 
functionality differences:

File, Config, Win/OS, and Analysis menu options
The first four menu options function using information from the machine where CheckIt PRO: Analyst was 
installed (a.k.a.    the physical machine), or with data collected from other PCs by loading a CKDATA file.

Tests menu option
The menu option entitled Tests performs diagnostics on the machine where CheckIt PRO: Analyst is installed only.
If you wish to test other machines, use the CKMOVE utility to copy the applets to a floppy.

Window and Help menu options
Finally, the Window and Help options correspond to the CheckIt PRO: Analyst software itself, regardless of the 
machine or CKDATA file installed.

See also:
File Menu
Config Menu
OS/Win Menu
Analysis Menu
Tests Menu
Window Menu
Help Menu



Save Data As
The Save Data As command opens the dialog box shown below.      This option allows you to save a copy of the 
currently loaded    CKD file under another name.     In addition, you can change the description of any CKD file 
using this command.      

See also:
Collect Data
Load Data
Report Viewer



SysInfo Report
The SysInfo Reports command provides comprehensive reporting of system information in one location.    The 
system information data is grouped into three reports:    Basic Information, Setup Information, and Detail System 
Information.     Within each report, you can select which information you want by checking the boxes.      To include
all the information, select the All Reports check box at the bottom of the screen.      When you have finished making
all of your selections, press the OK button to proceed to the CheckIt PRO: Analyst report viewer.      

See also:
Collect Data
Load Data
Report Viewer



Test Journal
Each test creates a Test Journal which shows the results of each step of the test.    Normally, tests complete and 
identify any failures.      However, if system problems prevent a test from even completing, you can analyze the 
journal to identify which part of the test caused the more drastic failure.    

CheckIt PRO: Analyst always names the Test Journal files with a JNL extension and stores them in the REPORTS 
subdirectory.      When you run a test, the current .JNL (and .RPT)    file for that test are deleted and new ones are 
created by the test program.    After the test or tests is complete, the CheckIt PRO: Analyst Report Viewer will 
automatically open to view the report.        If you wish to save a report for later use, use the Save As command and 
give the file a new name and/or extension.

See also:
Report Viewer



Test Results
When you run a test  in CheckIt PRO: Analyst, a file containing the results of the test is created including which 
test steps passed, which failed, and which were skipped (and why).      

CheckIt PRO: Analyst always names the Test Result files with a RPT extension and stores them in the REPORTS 
subdirectory.      When you run a test, the current .RPT (and .JNL)    file for that test are deleted and new ones are 
created by the test program.    After the test or tests is complete, the CheckIt PRO: Analyst Report Viewer will 
automatically open to view the report.        If you wish to save a report for later use, use the Save As command and 
give the file a new name and/or extension.

See also:
Report Viewer



Exit
Selecting Exit from the File menu or the Exit Icon shown above will quit CheckIt PRO: Analyst and return you to 
the state of the Program Manager in Windows that was open prior to opening the program.



File Menu
The File menu provides the commands to collect system information and save to a CKD file, or to load an existing 
CKD file.      You can also view, print and save system information reports.    This information can be studied from 
CheckIt PRO: Analyst Report Viewer.      The command for quitting    CheckIt PRO: Analyst is on this menu as 
well.      

Click on the desired area of the File menu for specific help

See also:
Gathering Data on Multiple Machines
Gathering Data on OS/2 Machines



Config Menu
The Config menu will provide you with system setup information about a specific machine.      This information is 
stored in the machine's CKD file.        From the details under the Config menu, you can become quite familiar with 
what you system has installed, and what can be added to enhance the machine.      You can view, and save your 
CMOS settings, check what hardware interrupts are assigned to see which are assigned, free, and which indicate 
conflicts, and view the assigned and available I/O addresses.

Click on the desired area of the Config menu for specific help



Hardware Configuration 

With the Hardware command, you can view in-depth details on major system components for the system on which 
data was collected.    When you first see the Hardware Detail window, you will see the window shown below.    On 
the left of the window is a list box with various parts of the hardware configuration.      Select the one you want to 
view.      Main System is automatically selected when the Hardware Detail window first appears.



Network Information 

The Network Information Screen displays all relevant information about the current workstation with respect to a 
network to which it is attached.      The following information will be displayed:

Server
Current Server--The name of the server to which this workstation is attached.
Network Type--The type of network to which the workstation is attached.
Revision Date--The revision date of the network driver.
Serial Number--The serial number of network server software.

Workstation
User ID--The network login ID of the current workstation.
Login Time--The time when this work station was logged into the server for the current session.
Connection--The connection number for this work station.
Node Address--The address that the network has assigned to this workstation.
Shell Version--The version of the shell software on the workstation that provides the communications link 

between DOS and NetWare (Novell Specific).
IPX/SPX Version--The version of the IPX/SPX running on the workstation.      This is the inter-network 

packet exchange    installation to the particular network interface card on the work station (Novell Specific).
Network Card--The name of the network card installed on the work station.
Configuration--The configuration of the network interface card.      This includes the hardware interrupt 

(IRQ) reported by the interface card, the base I/O address, and whether the card uses DMA or internal RAM.



Memory 

The Memory function on the Config menu allows you to view information about the computer’s memory usage.      
There are four options for viewing memory information, including    Base/Upper, Extended (XMS), Expanded 
(EMS), and Windows.

The information shown in the Memory screens is how memory looked (DOS and Windows) when the data was 
collected - not as of now.      Below are the four memory detail screens available.      To switch between them, press 
the button labeled with the type of memory you wish to view.

Base Memory
The Base Memory screen shows the full 1MB of DOS Memory  in both graphic and text form.      It is divided into 
two primary areas:    base memory and upper memory.      As you progress along the graphic representation of the 
DOS    memory area from Base to Upper memory, a "Summary" list    of the full DOS memory region is presented 
as well as    the "Notes" list box with specific information about the    area to which you are pointing.      

Extended (XMS) Memory 
The Extended Memory or XMS menu option shows XMS memory usage.      Extended memory is simply the 
physical memory above 1MB while    XMS is the logical allocation of that memory according to the    eXtended 
Memory Standard.    Because this function really measures XMS usage rather than raw    extended memory, it 
works only when HIMEM.SYS or and equivalent    driver for XMS is installed.    

Expanded (EMS) Memory
Like XMS memory, EMS-managed memory doesn't have physical    addresses.      Instead, its address space is 
allocated logically,    using handles that point to addresses that can change as    necessary.      The bar at the top of 
the Expanded Memory (EMS)    Memory Map screen represents this logical space.      

Windows Memory
This screen will show you how memory is being used by Windows.    The blue bar at the top of the screen 
compares how much physical memory your machine has to the size of the 386 Enhanced Mode swap file.    You 
will also be able to tell if your swap file is permanent or temporary, the amount of system resources being used, 
and amount of memory available after the resources are used.



TSR List 

The TSR List screen displays all Terminate and Stay Resident  programs and drivers loaded into memory when the
system data was collected.       This screen allows    you to see where and what TSRs are loaded, and how much 
memory is used.      The list box is separated into the Base Memory and the Upper Memory areas, and when 
appropriate, free areas are noted, so    upper memory can be used rather than valuable base memory.      

The following information is displayed in the list box:

Memory Location--The starting and ending memory locations for the driver or TSR indicated.
Size--The size in memory allocated to the driver or TSR indicated.
Description--A description of the TSR or device driver indicated.      The environment    space for various 

TSRs or drivers are also displayed.

See also:
Memory



CMOS Data 

The CMOS Data function allows you to view and save CMOS information.      Keep in mind that the CMOS file 
you see is extracted from the CKD file for the PC you are analyzing.      To save the CMOS file outside of the CKD 
file (to restore a system's CMOS) use the Save As button.      To restore a system's CMOS, save the data shown in 
the CMOS Data window, and use the CheckIt PRO applet CKCMOS.



IRQ Analysis 

The IRQ Analysis window    displays the sixteen IRQs (eight on an XT class PC) and their availability on a PC.      
Many of these will already be marked "In-use" by the basic hardware and software components of the PC.      
Available IRQs will be marked FREE" and are available for assignment to new devices.      The "CONFLICT!" 
message points out that two or more devices have been assigned the same IRQ.

For some kinds of hardware (e.g., network cards and tape drives), CheckIt PRO: Analyst can only determine if an 
interrupt is in use when the appropriate device driver is installed and activated.      Therefore, the IRQ Analysis data
may be incomplete if the appropriate drivers are not installed.

The following labels are used in the IRQ Analysis window:

IRQ--The IRQ number.
Standard--The normal use of this interrupt.      This information provides a comparison to standard usage 

and need not match this computer's use of the interrupt.
Status--The status of the interrupt, In-Use, N/A, FREE, Available, or Conflict!
Actual Hardware--The hardware device assigned to the interrupt.      
Device with no IRQ--Shows any devices found without an IRQ assigned to it.
Device with unknown IRQ--Due to circumstances beyond what CheckIt PRO: Analyst can control, some 

devices may be unable to be linked to an IRQ.

A note about the [CASCADE]
If the machine on which you collected data is an AT or later class PC, IRQ 2 will display [CASCADE].    All PCs 
use either one or two Intel 8259A interrupts controller chips to detect and process IRQs.    Each 8259A is capable 
of handling eight separate interrupt signals.    In order to get two 8259As to work in one system, the second 
interrupt controller (known as the slave) is connected to the first (known as the master) via one of the normal IRQ 
lines.    This IRQ line is known as the "Cascade" interrupt.    Whenever the slave 8259 receives an interrupt, it tells 
the master 8259 using the cascade interrupt, which then forwards it to the processor.    IRQ 2 is used for this 
purpose in AT and higher class machines.

Plugging loopback plugs into the serial and parallel    ports will prevent possible system lockup when the interrupts 
of    those ports are checked.      

See also:
Loopback Plugs 



Interrupt Vectors
The Interrupt Vectors function allows you to view information  about the PC's 256    hardware and software 
interrupts.     This function is useful for examining how interrupts are being used.      Such information can be 
helpful when tracking down    software conflicts, particularly those caused by TSRs and    other resident programs.  

The Interrupt Vectors window lists interrupts in order by number.      The labels in the Interrupt Vector display are 
described below.

Int--Interrupt number (hex).
Usual Function--The normal use for each interrupt.      Notice that several interrupts have very specific 

purposes, while others are either marked "reserved" or are used by several common    applications.

Note that the Usual Function field describes the common use for each interrupt, 
not how it is currently being used.

Address--The address to which the vector is currently pointing.     The values shown are the hexadecimal 
segment and offset respectively.

Points To--The location to which each vector is pointing.      In many cases, the vector will be pointing to an
operating system component like the system ROM, DOS kernel, or COMMAND.COM.      

Sometimes the vector will be pointing to a TSR or device driver.



I/O Address Map
The I/O Address Map displays port address assignments  for each I/O port and the device associated with that port. 
Input and output ports (I/O Ports) are used by the processor    to control many parts of the computer.      Each port is 
identified    by a 16-bit port number.      This port number is used by the processor to identify each port.      

Unknown areas are grouped together since multiple 8-byte unknown increments (the lowest granularity of the I/O 
addresses) may be contiguous.      Thus, large portions of the I/O address map will be    occupied by these 8-byte 
increments.      The information below is listed in this screen:

Start --The beginning byte in hexadecimal of the I/O address.
End--The ending byte in hexadecimal of the I/O address.
Size--The size of the I/O address area occupied by this port in bytes (this is the number if I/O ports used by 

this device).
Used By--The description of the device using these I/O port numbers.

Note that if "<unknown>" is indicated, there may be multiple devices using the port numbers specified.

As mentioned above, increments of 8 bytes are the smallest allowable to set an I/O address.      It is possible to 
query an I/O address to see if there may be a device attached, and many devices have methods of identifying 
themselves through port addresses.

Input and output ports (I/O ports) are used by the processor to control many parts of the computer.      There are 
special control chips for many of the hardware devices such as the keyboard, the serial ports, the system timers, 
etc.      These chips are communicated with by way of I/O ports.      Each port is identified by a 16-bit port number.   

Certain hardware devices allow the user to set switches to determine the I/O port.      Network cards, for example, 
can be set to a particular I/O address.      It is important to be able to determine which addresses are available to 
avoid conflicts.



Device Drivers 

The Device Drivers command displays information about all device drivers available to DOS.      Information 
displayed for each driver includes address, size, name, and technical characteristics.      This information is useful 
for verifying proper installation and for checking compatibility.

The DOS    Device Drivers screen uses the following labels:

Seg:Off--This is the driver’s address in memory.      The values displayed are the hexadecimal segment and 
offset, respectively.

Attr--This is the driver’s hexadecimal attribute.      Meaningful information gleaned from this value is 
displayed under Description/ Characteristics.

Size--Amount of memory used by the driver (if any).
Name--This field lists the name of each driver, such as COM1 or    B:.
Description/Characteristics--The first line provides a more descriptive name for each driver (wherever 

possible).        The second line lists important characteristics for each driver.



BIOS Data  

The BIOS Data function displays the values    stored in the BIOS Data Area.      The system uses this area of    
memory to track the states of system elements, such as the keyboard, video, disk drives, and serial and parallel 
ports.      This information is useful as an easy reference of port address values and/or installed hardware and 
memory sizes.    



Hard Drive Table 

The Hard Drive Table command displays information from the hard drive table stored in the CMOS memory of the
computer.      This table defines standard hard drive configurations that can be installed in, or connected to, the 
machine.      This information is useful when you’re adding a new hard drive, since you will normally need to 
match the new drive to one of these standard types.

Note that some of the newer BIOSs also allow you to add "user-defined" configurations for hard drives that don’t 
match, or come close to matching, the standard types.      As drives get bigger, more and more of them fall into this 
category.      Since the hard drive table is stored in CMOS memory, this function works only on machines that use 
CMOS.    If you are using a CKD file from a machine that does not have CMOS, then this option will not be 
available.

When you select the Hard Drive Table command, the    following information is available:

Type--The numbers displayed in this field represent standard configurations.
Size--Physical storage capacity of the drive in megabytes.
Physical Descriptions--Number of cylinders, heads, and sectors on the drive.      
Write Precomp--Specifies the cylinder number at which the densities must be    increased when writing to 

the disk.
Park Zone--The safe area (cylinder) for head to position itself at rest.
Step Rate--The rate at which the head moves from cylinder to cylinder.
Control Byte--The control byte specified for this drive type.

On newer drives, such as IDE, SCSI, and ESDI, the control parameters Write Precomp, Park Zone, Step Rate and 
Control Byte are irrelevant due to the manufacturing differences of the drives.



Win/OS Menu
With the commands on the Win/OS menu (Windows/Operating System), you have easy access to all the 
information about the platforms on which your computer can operate.      In addition, you can modify the 
information in the system files these platforms require.

Click on the desired area of the Win/OS menu for specific help



Windows Summary 

When you choose the Windows Summary command from the Win/OS menu, a 
list box will appear showing the status of Windows information for the 
current machine being viewed.      If Windows is not loaded on the machine, the CKD file will make this selection 
unavailable.        

Windows Summary Components
The Windows Summary information is separated into the following categories:

Version--Information about the version of the Windows program file, its location on the hard drive, and 
other specifications.

Setup--Information about the location of the Windows files, the operating system used, and the various 
drivers for input and output devices.

Keyboard--Information about the type of keyboard installed.
Display--Information about the video system, and its capabilities.
Mouse--Information about the mouse, its driver, and settings.
Memory--Information about the mode memory is being run under (e.g.    Enhanced, 386).
Devices--Information about the devices installed with the driver loaded.
Fonts--Information about the fonts that are installed and which are being used as default.



Report Viewer
The Report Viewer is used to analyze the results of a test run in CheckIt PRO: Analyst, or when selecting the 
SysInfo Reports command.      When you run a test in CheckIt PRO: Analyst, two files are created, one containing 
the results of the test and the other showing a journal of the testing process.      When you select SysInfo Reports, 
another file is created with detailed system information.

Report and Journal Files
CheckIt PRO: Analyst always names the Test Results and Test Journal files with a filename describing the test, and
extensions RPT and JNL respectively (e.g.    CKHD.RPT is a report for the hard drive test, CKFD.JNL is a journal 
for the floppy drive test).      The SysInfo Report command creates three files based on the sections of information 
available: CKBASIC.RPT, CKSETUP.RPT, and CKDETAIL.RPT.        These files are automatically placed in the 
REPORTS subdirectory.

When you run a test, the current .RPT and .JNL files for that test are deleted and new ones are created by the test 
program.    If you wish to save a report, you must either use the Save As command in the Report Viewer or copy 
the file using the Windows File Manager.

Viewing Files with the Report Viewer
The Report Viewer allows you to view, print, and save the test results and journals generated by the tests in 
CheckIt PRO: Analyst.      Whether you are viewing reports or journals, the report viewer functions the same.      
When you use the report viewer, the most recent report or journal is shown.      

Report Viewer Menu Options
The File menu on the report viewer provides the following commands:

Open--Presents a standard Windows open dialog box allowing you to find and select a file to open.    The 
default is either *.RPT or *.JNL, depending on if you originally selected Test Results or Test Journals.    You can 
overwrite these defaults and find any file.    However, the report viewer will not accept any file greater than 30K.

Save As--Allows you to save a copy of the report or journal being viewed.
Print--Prints the report.
Print    Setup--With this command you can choose to print only a portion of the report , select multiple 

copies, and specify other printer options.
Close--Closes the Test Viewer window.

The Edit menu on the Report Viewer provides the following commands:
Copy--Copies the selected text to the clipboard.      You can then place this text in another file, such as a 

report you are writing.
Find--Initiates the find for the target text found in the Search For box on the report viewer window.      This 

command has the same function as the Find button on the report viewer window.

See also:
SysInfo Report
Test Results
Test Journal



Device Capabilities
The Device Capabilities command displays information on all the devices loaded into Windows when the data was 
collected.    This includes the display and all the printers for which drivers were loaded.

The list box at the left of the window lists all the devices for which drivers have been loaded.    Select the device 
you wish to view and the information box on the right lists the following information on the device:

General Information
The details in the General Information section provide the numeric availabilty for devices including: 

Dimensions
Colors
Fonts
Pixels
DPI (Dots Per Inch)
Palletes
Resolution

Other Information
Listed in the Other Information category are the Driver Version and Technology coded information,    and 
support/ability for Clipping Capabilities (CLIPCAPS or CP) and Raster Capabilities (RASTERCAPS or RP). The 
following are explanations for the CP_ and RC_ details:

CP_RECTANGLE--Whether or not the device can clip to    a rectangle.
RC_BITBLT--Whether or not the device is able to transfer bitmaps.
RC_BANDING--Whether or not the device requires banding support.
RC_SCALING--Whether or not the device requires scaling support.
RC_BITMAP64--Whether or not the device can handle bitmaps larger than 64K.
RC_GDI20_OUTPUT--Whether or not the device can support Windows version 2.0 features.
RC_DI_BITMAP--Whether or not the device supports DIB to memory.
RC_PALETTE--Whether or not the device supports a palette.
RC_DIBTODEV--Whether or not the device supports bitmap conversion.
RC_BIGFONT--Whether or not the device supports fonts larger than 64K.
RC_STRETCHBLT--Whether or not the device supports the StrtechBlt function.
RC_FLOODFILL--Whether or not the device supports the FloodFill function. 
RC_STRETCHDIB--Whether or not the device supports the StretchDIBits function.



System File Editor
The System File Editor allows you to modify system files used by DOS, Windows, and OS/2.        It is important to 
keep in mind that you will be viewing and editing the files that are extracted from the CKD file of the machine you
are currently analyzing.      When you make changes and save a system file in CheckIt PRO: Analyst, that file is 
stored in the DATA sub-directory.

To choose the system file you wish to edit, click on one of the buttons shown below that has that filename on it.      
Note that like the Report Viewer, the System File Editor only handles files 30 kilobytes or smaller.      The Close 
button will quit the System File Editor.      If you have made changes to a file, you will be prompted to save or lose 
those changes before leaving the editor.

The three Menu Options for the System File Editor are listed below:

File Menu
New File--This button clears the screen so you can start a new file from scratch.
Open--Presents a standard open file dialog box so you can open any file of your choosing.    
Save--Allows you to save the edited file over the old file.      Make sure you always save a copy of your old 

system files, using Save As, for recovery in case the new file doesn't work as intended.
Save As--Allows you to save the current file under any filename you specify.
Print--Brings up a standard print dialog box, allowing you to print the file.
Page Setup--Allows you to specify the printer to which you want to print the file and set printing options.
Close--Returns you to the main window of CheckIt PRO: Analyst.

Edit Menu
Undo--Reverts back to previous editing step.
Cut--This removes highlighted block, storing information in the Windows Clipboard.
Copy--Copies highlighted block to the Windows Clipboard
Paste--Copies text from the Windows Clipboard to the System File Editor.
Delete--Removes highlighted block, but does not store the information to the Windows Clipboard.

Sections Menu
Sections--INI files are conveniently arranged in sections.      These sections are defined by a section name in

square brackets on a line by itself.      Choosing the Sections button will bring up a list box of all the sections.      
Choosing a particular section from this list box will automatically bring you to that section in the Edit list box.      
This menu item has no function for non-INI files.



First Screen Choices
When CheckIt PRO: Analyst first loads, you will see the screen below.    You must choose from one of the three 
options, depending on which CKD file you wish to load, or if you want to collect data now.



DOS summary
When you choose the DOS Summary command from the Win/OS menu, a 
list box will appear showing the status of DOS information for the 
current machine being viewed.      

DOS Summary Components
The DOS Summary information is separated into the following categories:

DOS Version--Numerical value, version of DOS.
Comspec--Location of COMMAND.COM.
Boot Drive--Drive DOS boots from.
Manufacturer--Company which published DOS.
DOS loaded in--Memory area where DOS is loaded.
Last Drive--The assigned last drive DOS will access.
Available Handles--List of memory handles available.
Files--Set number for FILES= in CONFIG.SYS.
Buffers--Set number for BUFFERS= in CONFIG.SYS.
Share--Whether or not SHARE.EXE is currently loaded.
Print--Whether or not PRINT TSR is loaded.
Memory Manager--Names memory managers if loaded.
Disk Compression--Names disk compression utility if loaded



DOS Drive List 

The Drive List function displays usage information for disk drives installed in, or connected to, your computer.      
This    information shows you what drives DOS recognizes, what capacity they have, and their current usage.      

Drive List Components
The following information is available on the Drive List:

DOS Name--The logical DOS drive name assigned to the drive such as A:, B:, C: etc.
Type--The physical type of drive, such as floppy, hard, network CD-ROM, or redirected/assigned.
Size--Physical storage capacity of the logical drive indicated (in megabytes).
Free--Amount of physical storage space currently available (in megabytes).
% Free--Overall percentage of physical storage space currently available for the drive.
Compression--Identified compression utility used such as Double Space or Stacker.



Environment Variables
The Environment Variables screen shows you the set of strings    in DOS    that manipulate how your computer is 
customized.      These are the same strings you will see if you type the SET command from DOS.

DOS automatically allocates an area in memory of between 160 bytes and 512 bytes (depending on the version of 
DOS) for environment space.        This space is used for a number of things which are defined in the CONFIG.SYS 
or AUTOEXEC.BAT files and placed into memory during the boot process.      Listed below are examples of what 
the environment space will do for your PC:

It holds a string showing the place on the disk where COMMAND.COM is stored (using COMSPEC).
It sets what the DOS prompt looks like if different from the default (using PROMPT).
It can hold a string defining an alternate for COMMAND.COM (using SHELL -- which also can be used to

increase the environment size).
It holds a string showing the current path (using PATH).
It can hold strings which are very rapidly accessible to application programs.
It can hold a string telling DOS and Windows where to store temporary files (using TEMP).



Tests Menu
The Tests Menu provides a core set of diagnostic tests for your PC.      Using the Tests menu, you can choose to run
the entire set of tests at once or choose the specific test you want to run.      Each test generates a report and a 
journal that may be saved for later report consolidation and comparison.      Unlike the information and analysis 
functions, these tests run immediately (and only) on the PC running CheckIt PRO: Analyst.

Click on the desired area of the Test menu for specific help

See also:
Test Results
Test Journal
Report viewer



Test Everything
The Test Everything command automates the selection of tests from the menu.      Each test is started automatically,
in the order the tests are on the menu, which is the order shown below: 

System Board Test
Serial Port Test
Parallel Port Test
Hard Disk Test
Floppy Disk Tests
Memory Tests

One report and one journal are created when you run Test Everything.     All the information from all the tests is 
placed in the report and journal files; one test does not write over the results of the next as in the case when the 
tests are run separately.

Because Test Everything includes the Memory test which exits Windows to run, there will be a message box 
warning you that CheckIt PRO: Analyst will quit Windows to test.    You will have the opportunity to cancel or 
continue.    If you continue, Windows will not re-open any other programs already open before you started the test.

Results from the Test Everything function are automatically written to two files: TEVERY.RPT is the report file 
and TEVERY.JNL is the journal file.      These files are stored in the REPORT sub-directory.    

To interrupt the test sequence after it starts, press <ESC>.    This will stop the tests.

See also:
System Board Testing
Serial Port Testing
Parallel Port Testing
Hard Drive Testing
Floppy Drive Testing
Memory Testing
Testing Memory from DOS
Testing Memory from DOS
Test Results
Test Journal
Report viewer



System Board Testing 

The System Board Test checks the primary internal components of your computer in the manor listed below.      The
tests start as soon as you select the System Board Test.    To stop the test at any time, press <ESC>.

System Information
Values in this area show the types of processor, coprocessor, and real-time clock CheckIt PRO: Analyst has 
identified, as well as the types and number of DMA and IRQ controllers.    

Central Processor Test
This test checks several key functions of your machine’s CPU:

General Function--Checks the general, math, and logic instructions of your CPU.    A failure here indicates
a major failure in your PC’s main processor.    

Interrupt Bug--Identifies CPUs that allow interrupts to occur at incorrect times.    This problem is found 
mainly in older 8088 and 8086 CPUs.    

Multiply Bug--Identifies a problem with 32-bit multiplication on early 80386 processors.    
Protected Mode--Checks the ability to function in protected mode.

Numerical Coprocessor Test
These tests verify that your math coprocessor is functioning correctly.    If there isn’t a coprocessor installed, this 
test will be skipped automatically.

Arithmetic--This test asks your math coprocessor to perform a number of simple floating point 
calculations.    Then it compares the actual results with the expected results.    If the numbers don’t match, an error is 
reported.

Logarithmic--This step uses the trigonometric functions available on the math coprocessor by asking it to 
compute a number of tangents.

Comparison--This step verifies that the coprocessor’s floating point comparison operations are working 
properly.

Real-Time Clock Test
The real-time clock test checks whether your machine’s battery backed-up clock is properly set and keeping 
accurate time.    If your system has a CMOS clock, the alarm function will also be tested.

Date Compare--Compares the date on the real-time clock to the date on the DOS clock.    
Time Compare--Compares the time on the real-time clock to that on the DOS clock.
Alarm Function--Tests a non-audible alarm on the CMOS clock hardware.
Elapsed Times--Compares the amount of time elapsed on both the CMOS and CPU clock to see if they are

keeping time at the same rate.    

DMA Controller Test
The DMA Controller Test checks to see that communication between your CPU and the DMA (Direct Memory 
Access)    controller is working properly.    The DMA controller is responsible for transferring data between various
devices and your PC’s memory without interfacing directly with the CPU.    

Interrupt Controller Test
This test verifies whether your PC’s interrupt controller is operating properly.    This controller is responsible for 
"interrupting" your CPU when certain events happen, such as when a key is pressed or a character is received over 
a serial port.    Normally, when an interrupt occurs, your PC momentarily stops what it was doing, runs a device 
driver to handle the event that generated the interrupt, and then returns to its previous task.

Results from the System Board Test are automatically written to two files: CKSYS.RPT is the report file and 
CKSYS.JNL is the journal file.      These files are stored in the REPORT sub-directory.    

To interrupt the test after it starts, press <ESC>.    This will stop the test.

See also:



Test Results
Test Journal
Report viewer



Memory Testing  

The Memory Test allows you to thoroughly test the system and video memory installed in your PC.      The memory
test will use multiple test patterns and techniques to find chip problems, test for address line problems and 
distinguish parity errors by row (not just by bank).      Through a number of techniques it will discover and isolate 
most types of memory problems that your PC may have including:

Bad bits
Bad parity
Bad address lines
Improper installation
Bad timing

Types of Memory Tests
CheckIt PRO: Analyst will test all types of memory it finds including the following: 
Base Memory--All base memory up to the 640k plateau is tested including memory currently being used by DOS 
or any other device drivers or TSRs loaded.    
Upper Memory--This is the memory range from 641k to 1Mb, and is tested not unlike the base memory area.
Extended Memory--All physical memory found beyond 1Mb.
Expanded Memory--All managed expanded memory beyond 1Mb (taken from extended memory), which will 
uncover any problems with either the actual memory or the memory manager.    
Adapter Memory--This is the RAM area for your video display (resident memory on the video adapter).

Together, these tests provide an extremely comprehensive suite of memory tests that can detect nearly all types of 
memory problems including parity and addressing errors.      Results of the Memory Test are automatically written 
to two files:    CKMEM.RPT is the report file and CKMEM.JNL is the journal file.      These files are stored in the 
REPORT sub-directory.    

To interrupt the test after it starts, press <ESC>.    This will stop the test.

Memory Test Problems
If your machine does not run the Memory Tests all the way through, you may want to try using the CKMEM.EXE 
applet from DOS, using a "Clean Boot" with no memory managers.    To test in this manner, type the following:

CKMEM /T:A /O:REPORT.RPT,A /O:JOURNAL.JNL,A /N:"User Note"

For more help on using the CKMEM applet, type:

CKMEM /?

See also:
Test Results
Test Journal
Report viewer
Memory



Serial Port Testing
The Serial Port Test option checks up to four COM ports on your    PC.      Each register of the 8250 serial controller
chip is tested    and data transmission is tested at different baud rates (up to    115K).      This test is helpful if you 
use a modem, serial mouse, serial printer, or data transfer product (i.e.    LapLink).      The serial port test will check
for port integrity, general operation, and baud rate generation.

 This test can be run either with or without a loopback connector (you must run the test from the command line 
with the appropriate switches to use a loopback plug).    Although CheckIt PRO: Analyst can still conduct a 
reasonable test without    a loopback plug, the test is best when using the plugs because data is actually sent and 
received by the port when an external loopback is used.    

If there is not a loopback plug connected, CheckIt PRO: Analyst uses the internal diagnostic mode of the UART 
chip to send and receive characters.    While this is an acceptable confidence test, it doesn’t test the functionality of 
the port under real conditions.

Results from the Serial Port Test are automatically written to two files: CKCOM.RPT is the report file and 
CKCOM.JNL is the journal file.      These files are stored in the REPORT sub-directory.    

To interrupt the test after it starts, press <ESC>.    This will stop the test.

See also:
Test Results
Test Journal
Report viewer
Loopback Plugs



Parallel Port Testing  

The Parallel Port Test option checks up to three LPT ports on your PC.      The test checks the internal registers of 
the UART chip and the entire character set through the parallel 
port.

 This test can be run either with or without a loopback connector (you must run the test from the command line 
with the appropriate switches to use a loopback plug).    Although CheckIt PRO: Analyst can still conduct a 
reasonable test without    a loopback plug, the test is best when using a plug because data is actually sent and 
received by the port when an external loopback is used.    

If there is not a loopback plug connected, CheckIt PRO: Analyst uses the internal diagnostic mode of the UART 
chip to send and receive characters.    While this is an acceptable confidence test, it doesn’t test the functionality of 
the port under real conditions.

Results from the Parallel Port    Test are automatically written to two files: CKLPT.RPT is the report file and 
CKLPT.JNL is the journal file.      These files are stored in the REPORT sub-directory.    

To interrupt the test after it starts, press <ESC>.    This will stop the test.

See also:
Test Results
Test Journal
Report viewer
Loopback plugs
Report viewer



Hard Drive Testing  

The Hard Drive Test is non-destructive and won't destroy any data on your hard disk.    Unlike some hard disk 
diagnostics, CheckIt PRO: Analyst tests the entire disk at the physical level, showing problems even on unused 
areas or non-DOS partitions.

Test Types
When you select the Hard Disk Test from the Tests menu, the first two installed hard drives will be selected for 
testing.    The following tests will be run on the drives:

Controller Test --Checks the physical interface from your computer to your hard disk. 
Linear Read--Verifies each track in order from outermost to innermost sector, ensuring that the data on 

your hard disk can be read successfully.    
Butterfly Read--This test also reads each cylinder; however, it moves the 
read/write head back and forth from the outermost cylinder, to the innermost cylinder, stressing the seek 

mechanism to its utmost

Results from the Hard Drive Test are automatically written to two files: CKHARD.RPT is the report file and 
CKHARD.JNL is the journal file.      These files are stored in the REPORT sub-directory.    

To interrupt the test after it starts, press <ESC>.    This will stop the test.

See also:
Test Results
Test Journal
Report viewer



Floppy Drive Testing  

The Floppy Disk Tests checks the mechanical operation of your floppy drives, as well as the media on individual 
floppy disks.    The tests are non-destructive, and no data will be lost. 

Test Types
When you select the Floppy Disk Test from the Tests menu, the following tests will be run on up to two floppy 
drives:

Media Surface Test--The media surface test will check a specific floppy disk for bad tracks.
Linear Read--Verifies each track in order from outermost to innermost sector, ensuring that the data on 

your floppy disk can be read successfully.    
Random Read--This test reads each cylinder much like the linear read test above, except it reads the 

cylinders randomly, much as it would in general operation. 

Results from the Floppy Drive Test are automatically written to two files: CKFD.RPT is the report file and 
CKFD.JNL is the journal file.      These files are stored in the REPORT sub-directory.    

To interrupt the test after it starts, press <ESC>.    This will stop the test.

See also:
Test Results
Test Journal
Report viewer



Memory Timing Errors
You may experience memory timing errors when you run the Memory Test if the nano-second access rates of your 
memory modules (e.g. SIMMS) do not match each other or the motherboard configuration.    This rate will usually 
be written somewhere    on the chips.    In the description "1 x 9 x 70", the chip is a one megabyte by nine chip by 
70 nano-second module.

The cause of this problem relates to the fact that the CPU uses RAM (Random Access Memory).    If data is sent to 
and from memory modules with different access times, it will become corrupted due to the inconsistency of the 
speed at which it is sent and received.



Analysis Menu
The commands on the Analysis Menu go beyond presenting factual information; they use the system and 
performance information to help you draw conclusions and make decisions about a system.    With these 
commands, you can evaluate the performance of a system, find the differences between two hardware and software
configurations, make software up-grade decisions using complete system information, and resolve conflicts before 
installing new hardware.

Click on the desired area of the Analysis menu for specific help



Rate Performances 

The Rate Performance command allows you to compare the performance of essential system components with up 
to ten other systems or with the data from same system at other times.    You can print a report of the performance 
values, and you can save the results for use in later comparisons.    Benchmark information is saved in files with an 
extension of PRF and are automatically stored in the PRF directory, which was created at installation time. 

Performance is measured by CheckIt PRO: Analyst in three major areas:    performance of the system, the hard 
drives, and the video system.    These are the main components you can use to test the performance of a computer 
and judge its suitability for various tasks. 

The Performance Window
The Performance Window contains the following elements:

Component List--This allows you to choose the system components for which you wish to view 
benchmark information. 

Test Type--This allows you to choose from two or three performance benchmarks run on the selected 
system components. 

Current System--This is the description of the currently loaded CKD file.    The rank (a number from 1 to 
11    with 1 being best), indicates how the system compares to the other systems. 

Performance Bar Graph--This graph shows the performance data (of the selected type) from the currently
loaded CKD file and up to ten selected performance files. The value for the currently loaded CKD file is graphed 
first in red and the other systems are graphed in green (with one of the "other" systems in blue).

Changing Performance Files
To remove a file from the Selected Systems list, either double-click on the file name or select the file name and 
then select the left-pointing arrow.    To move a file into the Selected Systems list, select the number in the list 
where you want that system to be (the number and any text should have be highlighted), then double-click on the 
file name in the left list that you want in the Selected Systems list.    You also can select the file name and use the 
right-facing arrow key.    If there is a file in the Selected System number already, the two files exchange lists.



Win/OS Differences
Using the Win/OS Differences command, you can compare the software setup on two different systems, or setup 
data for the same computer at different times to isolate changes.    The software setup for DOS, Windows and OS/2 
environments are examined for differences in:

Operating system version
Device drivers loaded
TSRs loaded
Displays supported
Setup definitions.

The Win/OS Differences window lists the two configurations and highlights the differences in red.    "Current" is 
the description from the CKD file currently loaded by CheckIt PRO: Analyst.    "Compare" contains the description
of the comparison file you just selected. 

Win/OS Differences Screen Components
The Config Differences screen has the following components:
System Description--The area at the top of the list displays the CKD file descriptions and the number of 
differences found for the software setup    values checked. 
Compressed Version--Shows only the differences.    All the headings are still displayed, but no software setup    
information is listed under a heading if there are no differences in that area.
Expanded Version--Shows all the compared software setup values of both systems, with the differences 
highlighted in red.
Select--Allows you to select a new CKD file for comparison.
Report--Choosing the Report button generates a report containing the software setup differences for the two files.   
The report is in a file called OSDIFF.RPT in the REPORTS directory.    

See also:
Report Viewer
CKD Files



Config Differences
Using the Config Differences command, you can compare system configuration data from two different systems, 
or compare data for the same computer at different times to isolate changes.    The system configurations are 
examined for differences in:

Hardware components
Network ID
Memory usage
Setup definitions (CMOS, BIOS or IRQ assignments)
Performance values.

The Config Differences window lists the two configurations and highlights the differences in red.    "Current" is the
description from the CKD file currently loaded by CheckIt PRO: Analyst.    "Compare" contains the description of 
the comparison file you just selected. 

Config Differences Screen Components
The Config Differences screen has the following components:
System Description--The area at the top of the list displays the CKD file descriptions and the number of 
differences found for the configuration values checked. 
Compressed Version--Shows only the differences.    All the headings are still displayed, but no configuration 
information is listed under a heading if there are no differences in that area.
Expanded Version--Shows all the compared configuration values of both systems, with the differences 
highlighted in red.
Select--Allows you to select a new CKD file for comparison.
Report--Choosing the Report button generates a report containing the configuration differences for the two files.     
The report is in a file called CONDIFF.RPT in the REPORTS directory.    

See also:
Report Viewer
CKD Files



Setup Advisor
The Setup Advisor allows you to compare the setup recommendations for add-on devices and adapter cards to a 
system’s actual configuration.    The setup items that are evaluated include:

IRQ Usage
DMA Channels
I/O Port Locations
RAM Address space
ROM Address space

Setup Advisor Components
Setup Advisor window contains the following elements:

Product List--This list includes those delivered with CheckIt PRO: Analyst and those you have added 
yourself.    All of the products are displayed, regardless of their origin, in alphabetic order by the name assigned.    

Hardware Product Names--A name has been assigned to each hardware product displayed.    To the right 
of the title is the type of adapter card, and displayed below is the name of the Manufacturer.    To the right of the 
Manufacturer name is the name of the file (with an ADV extension) containing the product information.

Setup Requirements Information--This area contains a series of numeric entry fields that describe the 
primary and alternate assignment requirements of the product. 

Hardware Product Information
For each hardware device, the following information can be indicated:

IRQ Assignment--You can enter up to four IRQ assignments.    Most products however will only have one 
or two suggested.    The range here should be 0-7 for XT class machines, and 0-15 for AT class or above machines.

DMA Channel--If the device you are installing requires one or more DMA channels, you can enter the 
suggested assignments here.    Because it is not possible to test for the actual use of DMA channels, a standard list is 
used to compare and suggestions are made for checking assignments.

I/O Port Address--Enter suggested I/O Port Addresses in Hex format.    The typical range of I/O Port 
Addresses is 000h to 3FFh.

Memory Addresses-Enter suggested Memory Addresses in Hex format also.    Up to four memory 
addresses can be specified.

Setup Advisor Buttons
The buttons on the bottom of the window give you access to the functions that use and maintain the hardware setup
information:

Close--Closes the Setup Advisor window.
New--Clears the Setup Advisor window of setup requirement information.    This allows you to start with a 

clean screen when you enter specifications yourself for a hardware product.
Save As--You can supplement the Setup Advisor library by adding hardware Products of interest to you or 

adding information about new hardware products.
Analyze--Generates an analysis indicating how the currently loaded system configuration matches the 

required setup for a hardware product and recommends specific setup assignments or identifies potential problems.
    
Setup Advisor Analysis
Once a hardware product has been selected or a setup entered, use the Analyze button to generate an analysis of 
how the system configuration meets its needs.    The analysis window displays Setup Advisor’s summary of the 
requirements expressed by the main setup screen, the availability information for each resource, and a 
recommended assignment or assignment problem description.

If a recommendation is made, you will be able to see the recommended resources (IRQ number, I/O Port Location, 
or Memory Address) listed immediately above as both "Requested" and "Available".    If a problem is cited, the 
conflicting device may also be noted, and you will see that the requested resource is not listed among those 
currently available.    You may want to refer to the detailed windows for each area to get more information, and 
either move another device or call the manufacturer for additional alternates.





Software Shopper
The Software Shopper allows you to compare the equipment capabilities of the current CKD file to the 
requirements of various software products.    CheckIt PRO: Analyst comes with a library of over 1,000 pre-defined 
software product requirements, and you can enter your own specifications as well.    Equipment capabilities 
checked by the Software Shopper are:

Processor
Memory
Disk space
Installation media
Operating system
Optional devices)

Software Shopper Buttons
The buttons found on the bottom of the window are as described below:

Close--Closes the Software Shopper window and returns you to the main window of CheckIt PRO: 
Analyst.

New--Clears the Software Shopper window so you can enter specifications for another software package.
Save As--CheckIt PRO: Analyst comes with a library of software product information.    You can 

supplement this library, adding software products of interest to you or adding information about new software 
releases. 

Analyze--Generates an analysis indicating where the system configuration matches the needs of the 
software product and where there are problems or potential problems.    

Vendor--Brings up the Vendor window, which shows information about the publisher and the suggested 
retail price.

Software Shopper Information
For each software package, the following information can be indicated: 

Software Title--The name of the software package.
Processor--The processor needed to run the software. 
Math Coprocessor--A math coprocessor may be required or optional. 
Operating System--The choices are MS-DOS, Windows and OS/2. 
Video--Whether or not video graphics are required. 
Memory Required--This is the minimum amount of memory (in Kbytes) required to run the software.
EMS Required--Whether or not the software requires EMS memory.
Disk Space--This is the minimum amount of disk space required for the 
software package.
Install Media--This identifies the types of media the software in which the software is delivered. 
Network--This identifies the type of network (if any) required by the software.
Other--This section contains components that a software package might require such as mouse, joystick, 

sound card, CD-ROM, modem and Fax card.
Category--The type of software.
Sug Retail Price--The suggested retail price of the software package.
Release Date--The real or projected release date of the software.
Company--The publisher of the software package.
Phone Number--The phone number of the publisher.    
Support Number--Use this number if you have the product and require assistance or support.

The results from the Software Shopper can be viewed from the Report Viewer, which allows you to view, save, and
print the report.    The Software Shopper report contains the software product information, the purchase 
information, and the analysis.





Window Menu
The Window Menu is a dynamic list of all the windows that have been opened in the current session.      

When several windows have been opened, their names will be listed under the Window Menu heading.    To go to a 
specific window, select it as you would any other menu option.    Use the Close All option when you no longer desire
the windows to be open.



This standard Windows list box contains all of the saved system configurations to which you can compare your 
system.



Help Menu
The Help Menu includes the Index of Help Topics, the Technical Reference Library, and the About screen.

Click on the desired area of the Help menu for specific help



Help Index
If you choose the Help Index option from the Help Menu, or press the icon from the toolbar shown above, the 
Contents screen of this help file will open.    To go to this point now, press the Contents button on the menu bar at 
the top of this window.    For assistance    on using the help file, choose the Help option, again at the top of this 
window.



This standard Windows list box displays all of the system configurations you have loaded in the Rate Performances
screen.



Reference Library
The Reference Library is a useful collection of PC, DOS and Windows reference material.    It is indexed by 
subject and will allow you to look up a great deal of information you would otherwise be forced to locate in 
various books.    The Library was written in a Windows help file format.    Like this help file, topics in the reference
library can be found by contents or by searching for a specific keyword.



About
Selecting the About menu option will display information about CheckIt PRO: Analyst, including: Version number,
copyright and licensee details, serial number, the Windows operating mode, and the amount of free memory 
available to Windows.



Loopback Plugs
CheckIt PRO: Analyst provides the option to uses three different    loopback plugs when testing serial and parallel 
ports    from the command line.    You must specify that you are using the plugs, with the /T:l option.    (For more 
help, type /? after the test name).        The parallel loopback plug can also be used during the view IRQ procedure 
for more accurate results.    Look in the Reference Library for diagrams of the loopback plugs if you wish to build 
them, or contact TouchStone to buy them.



A peripheral is classified as any external device attached to and controlled by a computer's CPU (Central 
Processing Unit).      



Real Mode is a type of PC operation where a program is given a specific storage area  in memory, and direct 
access to peripheral devices.      This mode can cause problems when more than one program is loaded into memory
at one time.      Programs loaded simultaneously in this mode can crash the system as they will try to share the same
memory area.      Using protected mode instead will solve this problem.



To solve the problems of Real Mode, where programs loaded simultaneously try to 
share the same memory area, Protected Mode was created, which prevents such 
interference.      Programs can be successfully loaded simultaneously in Protected Mode, which allows for multi-
tasking.    



An Interrupt ReQuest is an assigned value which controls instructions for hardware and software.      Each device 
must have its own IRQ, or a conflict will occur.      The CPU uses these IRQs to determine which devices are 
calling with input or output.      CheckIt PRO: Windows will display all devices and their IRQs.    



Described in hexadecimal format, I/O (Input/Output) assignments describe the 
channels in memory by which devices and the CPU communicate.      Each device will have its own unique I/O 
address.



In MS DOS versions 5.0 and 6.0, you can load DOS into the High Memory Area (HMA) to allow more room in 
base memory for other programs.      The line DOS=HIGH,UMB should be added in your CONFIG.SYS file.



Terminate, Stay Resident programs are loaded in to memory, and then are not visible until a specific keyboard 
combination (a.k.a.    hotkey) is pressed.      You can use the CheckIt PRO: Windows TSR map to see which TSR 
programs you have loaded, where 
they reside, and how much memory they are taking up.      Common TSR programs are:    DOSKEY, popup 
calculators, and E-Mail packages.



The Buffers= command in the CONFIG.SYS file specifies how many disk buffers are available when a PC boots.   
The buffer stores information from disk in memory, making access to information faster.    Too many buffers set 
can slow your system by using too much memory, and too few buffers set can cause conflicts with certain 
programs.



The LASTDRIVE= command is located in the CONFIG.SYS file, and dictates the total number of drives that can 
be activated.      



The DEVICE=  command is located in the CONFIG.SYS file, and is a device driver loading command.      For 
example, DEVICE=MOUSE loads the device driver needed for the system to use a mouse.      Each device will 
have its own specific device driver.



If you select the Collect Data Now option, CheckIt PRO: Analyst will take one to two minutes to gather system 
information and performance details.    This information will be written to    a CKD file, which is then stored in the 
DATA directory, which was created during installation.



CheckIt PRO: Analyst on a LAN
According to the product license, CheckIt PRO: Analyst may be installed on a network drive, but it is the 
responsibility of the licensee to ensure that only one person at a time can use the program.    To view data from 
multiple workstation, run the CKDATA program on each machine.    Then, to study each node, load the 
corresponding CKD file for that machine.    The information for that node can be printed out or saved for later use, 
inventory controll, or troulelshooting.



Finding differences between machines
You can use CheckIt PRO: Analyst to find differences between two machines, or the same machine at different 
times using the Config Differences from the Analysis menu.    A few reasons you would want to use this function 
are as follows:

Checking    "identical" machines--Take just a few seconds to ensure these machines are actually both 
hardware and set-up identical.

Taking inventory--See how a machine has lost or gained components over a period of time, and how the 
setup has changed.

Sending out for repairs--View differences made when the machine is returned.    Was the configuration 
modified?

Troubleshooting--The user says he didn't change anything and now the machine wont work.    Has 
anything really been modified?

Maximizing performance--As you make changes and run benchmarks, you can use the Config 
Differences command to track hardware and set-up modifications to find the optimal configuration.

See also:
Config Differences
Rate Performances



Collecting data on multiple machines
The CheckIt PRO: Analyst program is licensed to be loaded on one machine only, but you can collect    data from 
an unlimited number of machines using the CKDATA program.    Using CKDATA creates a CKD file, which can 
then be brought back to the machine where CheckIt PRO: Analyst is installed.    By using CKDATA, you now have
access to system information and performance data for as many machines as you like, all from one disk.    To load 
CKD files from other machines, use the Load Data command under the File Menu.

See also:
CKD Files
Collecting Data on OS/2 Machines
Load data
The CKDATA Program



Collecting data on OS/2 machines

To gather data on OS/2 machines, use the CKDATA program from the DOS Full Screen command.    It is 
important that you use the "Full Screen" version for proper results.    The other option under OS/2 is to use the 
Windows Full Screen option.    Both of these options will collect the data and create a CKD file from a DOS box.

See also:
Collect data
Collecting data on multiple machines
Load data



Installing devices
Before you install a new device to your PC, there is a set of information that you need to know to avoid a conflict 
in configuration including IRQ, I/O Port Address, ROM Address, DMA Channel and Memory Address. The Setup 
Advisor will help you make the right decisions about how to set up a new device so that it works right the first 
time.    You can even check to see if the recommended setup will work without conflicts, and if not, the Setup 
Advisor recommends alternate setup assignments.

See also:
Setup Advisor



Testing Memory from DOS
To test memory in the most efficient manner, CheckIt PRO: Analyst quits Windows when it runs the Memory Test. 
Because the current Windows session will end, you will be given a warning, and the opportunity to cancel or 
continue.    If you continue, any other programs that were open in the session will not be restarted when Windows 
resumes.    If problems still occur when running the Memory Test from the CheckIt PRO: Analyst program, try 
running the CKMEM applet from DOS.

See also:
Running the Applets from DOS
Memory Testing



Moving applets to a floppy
The tests in CheckIt PRO: Analyst are actually individual applets (mini-applications).    This allows you to move 
these tests to a separate floppy, network drive, or other location for remote testing.    Copying these applets is made 
easy through the use of the CKMOVE.BAT program.    This batch file will move the applets you specify to another 
path or disk, including any support files needed by any given test.

Using multiple copies of applets would violate the Standard License Agreement.    Only the CKDATA program can 
be copied freely for multiple users.    Therefore, a Multiple License Extension is available if copying the applets is 
necessary.    Contact TouchStone directly for details.    



Naming Convention of COM Ports
IBM PCs and compatibles have four standard base addresses for serial ports. These assignments are as follows:

3F8H --    (Port 1)
2F8H --    (Port 2)
3E8H --    (Port 3)
2E8H --    (Port 4)

The BIOS assigns port indexes in the order in which it finds the serial ports on the machine.    It searches for the 
ports by base address, proceeding in the order indicated above.    DOS assigns COM 1 to the first port it finds, 
COM 2 to the second and so on.    If you have a machine with two COM ports, one at 3F8H and IRQ 4 and the 
other at 3E8H and IRQ 4, then DOS would call them COM 1 and COM 2. The address 3F8H would be COM 1 and
3E8H would be COM 2.

CheckIt PRO : Analyst    shows the COM names assigned by DOS.    Communication software commonly do    not 
use the COM names assigned by DOS.      Therefore, CheckIt PRO: Analyst and a communications package may 
call the same port by different names. The most important information is the actual base address and IRQ.

Windows addresses the COM ports in the same manner as DOS,    but the Windows COMM.DRV may be confused
when a COM address is skipped over.    It expects certain COM ports to be addressed in the order shown above. To 
compensate for a missing COM address, you can add a NULL port to the SYSTEM.INI file.    For example, to skip
over the second port address, you would add the following lines to the [386Enh] section of your SYSTEM.INI file:

COM2IRQ=-1      (This disables the false COM 2 appearing in the BIOS data area)
COM3Base=03F8      (This sets the correct COM 3 address)
COM3IRQ=4      (This sets the correct COM 3 IRQ)



Files with an extension of PRF are performance files used in the Rate Performance option.    CheckIt PRO: Analyst 
ships with a group of PRF files, and as you create more, they will join them in the PRF sub-directory.



32-Bit Disk Access
What Is 32-Bit Access Mode
32-Bit Access works as a device driver that communicates with the hard drive controller.    This function looks for 
specific hardware interrupts (13H), and handles them directly, thus replacing the disk BIOS.

During installation, the Windows Setup program determines if your hard disk controller can use 32-Bit Access 
(although we have seen on some systems determination is incorrect).    If your machine has the ability to    use 32-
Bit Access, a check box in the Virtual Memory dialog window will be available.      Using 32-Bit Access increases 
the hard drive access time, and allows for more (and quicker) instances of the MS-DOS Prompt.

The Need to Disable 32-Bit Access
Due to the manner in which 32-Bit Access takes control of the hard drive controller, you must run CheckIt PRO: 
Analyst without using this option.    32-Bit Access does not allow any program to write back to the hard disk when 
in a DOS box.    CheckIt PRO: Analyst collects some system information and runs all tests from a DOS box.    32-
Bit Access does not allow CKDATA or the test applets to write to the report or journal files in this DOS BOX.    If 
your system is set up to run 32-Bit Disk Access, you must disable this function. 



Viewing multiple performance ratings



Receiving Parity Errors
If you are receiving parity errors when running the Memory Test, it may be due to the fact that your memory does 
not have a parity chip.    All true IBM compatibles will have this chip, but some clones do not.  CheckIt PRO: 
Analyst tests the functionality of the parity chip.    In the case where there is no parity chip, an automatic failure 
will result.

To verify whether you have the parity chip, you can count the number of chips on the memory module in your 
system.    Modules with nine chips do have the parity chip, those with only eight do not.    This same rule goes for 
modules that contain three and two chips respectively.



Press this button to copy a performance file from the Unselected list box to the Selected list box.



OS/2 summary
The OS/2 Summary command gives an overview of the OS/2 setup, based on information from the CONFIG.SYS 
as well as other information gathered directly from OS/2. If OS/2 was not installed on the computer when the data 
was collected, the OS/2 Summary command will be grayed. 

OS/2 Summary Components
The fields specified on the OS/2 screen are listed and explained below:

Version--OS/2 version number
Autostart--Parameters identify the workplace shell functions to be included.    Possible functions are 

Programs, Tasklist, Folders and Connections.    Leaving out a function disables this function.
Buffers--The maximum number of buffers allocated for buffering disk requests. 
Shell--The various shells installed
ComSpec--For versions earlier than 2.0, this identifies the location of the OS/2 command processor.
OS/2 Shell--Identifies the location of the OS/2 command processor (version 2.0 and later).
ProtShell--Identifies the location of the presentation manager shell that was loaded.
DOS--This indicates whether or not the DOS kernel is loaded in high (above 640K) memory.    
DelDir--This both enables the Undelete command and identifies the directories where OS/2 will store 

deleted files.    More than one directory may be identified.
DEVINFO--This identifies the video support routine loaded.    Possible parameters are: CGA, EGA, VGA 

and XGA (IBM 8514).
DiskCache--This is the size of the disk cache.
Path--The different path statements defined for use by OS/2.
Executable--The directory list used in locating executable files.
Library--The directory list used in answering request for dynamic link library (DLL) files.
Data--The directory list used in answering requests for data files.    This is similar to the APPEND 

command in DOS.
IFS (File System)--This identifies the Installable File Systems (IFS) that are loaded.    The most common 

one is the OS/2 High Performance File System (HPFS).
Keys--This ON/OFF flag indicates whether or not command line editing is available at the OS/2 prompt.
MaxWait--This is the number of seconds to wait before increasing the priority of standard waiting 

thresholds.
Memory Manager--This indicates the status of the memory manager.
PROTECT--Enables protected mode memory access to API calls.    If "PROTECT" does not appear, this 

access is disabled.
Printer Buffer Size--This indicated, for each LPT (1, 2,3 ), the number of bytes of memory used as a data 

buffer.
Protect Only--This indicates whether or not the system will only run in protected mode.    In protected 

mode, OS/2 will not run any DOS or Windows programs.
Swap Path--This indicates the location of the SWAPPER.DAT file, which is used for swapping memory to 

disk.
Threads--This indicates the maximum number of threads available.
BASEDEV--Listed are the base device drivers loaded at startup.    These basic interfaces include printer 

and disk drivers.
DEVICE--Listed are all the device drivers to be loaded when OS/2 is started.



Press this button to remove a performance file from the Selected list box.



Running applets from DOS
The tests in CheckIt PRO: Analyst may be run from the command line in DOS.    Each test is its own applet with a 
file name starting with "CK",    and continuing to describe the test (e.g. CKMEM.EXE is the memory test).    For 
help on a specific applet name, type the filename followed by /?.    



An applet is a mini-application. All the CheckIt PRO: Analyst tests are applets, and so is CKDATA.



If you select this option, CheckIt PRO: Analyst will display details from the last session, using the previously 
loaded CKD file. 



If you select this option, a list of available CKD files will be presented.    Choose the CKD file for the machine you
wish to analyze.



The CKDATA Program
The CKDATA program collects system configuration and performance data and stores it in a file with the 
extension CKD.    Use CKDATA to collect information on PCs other than the one where CheckIt PRO: Analyst was
installed.    

The CKDATA applet is completely compatible with Windows, DOS, and OS/2 systems.    While it runs as a DOS 
program on all of these platforms, it is aware of what type of system is being used and makes special notes about it 
in the CKD file.



The OK button carries out the command you have chosen.



The Cancel button closes the current dialog box and cancels the command you have chosen.



Pressing the Help button will open the help file specific to the current dialog box.      For more complex dialog 
boxes, there will be several help windows.      Use the help system browse buttons to see complete help for any 
given dialog box.



The Read Only option is controled by a standard Windows check box, which means you can select or clear the 
option.      In this case, if you elect to open a CKD file with the Read Only option checked, no changes to the file 
will be made.



CKD Files
CheckIt PRO: Analyst collects system configuration and performance data and stores it in a file with the extension 
"CKD".    In the manual and this help system, these files are referred to as CKD files.    In addition to collecting 
data from your own PC, you can also collect data about other systems using the CKDATA applet provided with 
CheckIt PRO: Analyst.    Running CKDATA on a machine where CheckIt PRO: Analyst is not installed will carry 
out the same function as selecting the Collect Data command under the File Menu.

See also:
Collect Data
The CKDATA Program
Collecting Data on OS/2 Machines



Pressing the Close button will exit you out of the current window.



Pressing the New button will clear the entries and allow you to start over with a new selection.



Pressing the Save As button will save your newly edited or created data to a filename you specify.



Press Continue if you wish to proceed after reading the warning in the message box.



Collecting data from DOS v.s. Windows
Because CheckIt PRO: Analyst allows you to collect data from multiple machines, and from various platforms, 
data collected from the same machine at almost the same time may vary.    For example, when you collect data 
from a machine from DOS (Windows is not loaded) using CKDATA,    you will not collect any Windows 
information.    Also, your machine will receive a higher System Performance rating.    When you collect data from 
the CheckIt PRO: Analyst menu, or by using CKWDATA, you will collect Windows information and System 
Performance ratings will not be as high.

To keep matters from becoming too confusing, use the Description field when collecting data or creating PRF files 
to denote whether or not Windows was loaded.    You will see that all the example CKD and PRF files included in 
CheckIt PRO: Analyst have either DOS or WIN in their filename and description.

See also:
CKD Files
CKDATA & CKWDATA
The CKDATA Program



CKDATA & CKWDATA
CheckIt PRO: Analyst allows you to collect data on multiple machines on multiple platforms by using the 
CKDATA and CKWDATA programs.

CKDATA
To collect data on a machine that only has DOS, use the CKDATA program.    You can either run CKDATA from a 
floppy, or copy it to a local drive.    Keep in mind however, that the CKD file generated by CKDATA will be 
written to the location from where CKDATA was executed.    For help on CKDATA, type:

CKDATA /?

To make exclusions when collecting data, use the following syntax:

CKDATA /X:xxx,xxx,xxx

where "xxx" is an element you wish to exclude in your data collection.

CKWDATA
If you want to collect data on a machine that has Windows loaded, you can choose between CKDATA and 
CKWDATA.    You may even want to run both to see how the configuration and performance varies.    To run 
CKWDATA on the machine where CheckIt PRO: Analyst was installed, simply double-click on the    CKWDATA 
icon, which was created during setup.    If you want to run CKWDATA on another machine that has windows 
loaded, select the File menu, Run command on the Program or File Manager and type in:

A:CKWDATA.EXE

To make exclusions when collection data with CKWDATA, click on the Exclusions button    and enter the 
appropriate exclusions in the fields provided.

See also:
Collecting Data on Multiple Machines
Exclusions



Exclusions
It is uncommon but possible for CheckIt PRO: Analyst to have hardware incompatibility problems when collecting
data due to the millions of different combinations of hardware and software that can be run together.    If this 
unlikely hanging occurs during data collections, you can exclude the device that is not responding correctly to 
CheckIt PRO: Analyst's inquiries.    

The component that causes CheckIt PRO: Analyst to hang will be listed in the data collection box.    To bypass this 
device, use the appropriate exclusion from the list below:

DOS Exclusion
BEN Exclude gathering benchmark data
FIL Exclude gathering files data
HD Don't check for hard drive information
FD Don't check for floppy drive information
VDO Don't check for super-VGA chipset or video memory
IRQ Don't check IRQ assignments
COM Don't check serial ports
LPT Don't check parallel ports
SND Don't check for sound cards
EMS Don't check for expanded memory
BUS Don't identify the bus architecture
NPU Don't check for a math coprocessor
IOP Don't check the I/O ports
BIOS Don't check the I/O ports directly, use BIOS

Windows Exclusion:
DEV Don't collect Device Capabilities information
FIL Don't collect WIN.INI and SYSTEM.INI
GEN Don't collect general Windows information

Exclusions when collecting from DOS (CKDATA)
When using the CKDATA file to gather data from DOS, you can use the following syntax to add the exclusions and
collection limitations:

CKDATA filename /X:xxx,xxx,xxx,xxx,xxx /N:"Description"

The "/X:" is a command switch that allows you to add the exclusions to the CKDATA command.    Replace "xxx"
with as many exclusions as you like, being sure to place a comma in-between each exclusion.

Exclusions when collecting from Windows    (CKWDATA)
When using the CKWDATA file to gather data, click on the EXCLUDE button and enter the exclusions before 
running the program.

Exclusions when collecting inside CheckIt PRO: Analyst
When using the Collect Data command from the CheckIt PRO: Analyst File menu, you will not be prompted for 
exclusions. The exclusions are set in the CKANLYST.INI file, under the [EXCLUSIONS] section, as shown in 
the example below:

[Exclude]
DOS=HD, IRQ, LPT
Win=DEV, FIL



Choose this option if you wish to collect data now.



Direct Memory Access (DMA)
By using Direct Memory Access, or DMA, components on your computer can transfer information without passing
it through the CPU.    Avoiding the need to send data throught the CPU saves a considerable amount of time.    
DMA is used maily for transferring data to and from hard disks, but is often utilized by backup programs to 
improve speed by directly transferring data from the hard disk to floppies.    This process is controlled by the DMA 
controller chip.    PC and XT class machines have one DMA controller chip, and AT and later class machines have 
two.

DMA Availability
Unlike detecting IRQs assignments on a PC, channels used by    DMA are not available.    Devices only occupy a 
DMA channel while in use, whereas IRQs are assigned more permanently (although they can be changed manual). 
Common DMA channel assignments for are PC and AT type machines are shown below:

PC and XT compatible machines:
DMA0 Used by system (not available on bus)
DMA1 *
DMA2 Floppy disk controller
DMA3 Hard disk controller

AT compatible machines:
DMA0 Used by system    (16 bit)
DMA1 *    ( 8 bit)
DMA2 Floppy disk controller      ( 8 bit)
DMA3 *    ( 8 bit) 
DMA4 [CASCADE] - Slave DMA controller input into master
DMA5 *    (16 bit)
DMA6 *    (16 bit)
DMA7 *    (16 bit)

 * = No standard DMA assignment; you can assign these DMA channels to devices not listed that can be 
configured for DMA.

Testing the DMA Controllers
In the System Board Test, CheckIt PRO: Analyst checks to see that communication between your CPU and the 
DMA controller is functioning properly. If there is a failure, either your DMA controller, or the CPU is not working
correctly.    The System Board Test will automatically check both.    Each channel and register is checked, and the 
refresh function is tested.    Problems with the refresh cycle can cause what might otherwise appear to be memory 
errors.




